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What is a Digital Memories Preservation Lab? 

The Digital Memories Preservation Lab (DMPL) is a service offered by Las Vegas-County 
Library District. It is meant to help preserve and share media that is in danger of physical 
deterioration and technical obsolescence as the equipment required to use it becomes 
harder to find. 

Library customers can use the Digital Memories Preservation Lab equipment to digitize, 
edit, and store personal media such as home movies on videotape; images including 
photographic prints, slides, and negatives; and audio cassette tapes. We provide the 
equipment and basic help, and then it’s up to you to transfer your media. 

This project was initiated with help from our Executive Director. 

Why Should I Care about Personal Archiving? 

Daily organization 
Personal collections are larger than ever, spanning physical things like keepsakes and 
journals, to digital things like Word documents, photographs, email, and video. Taking 
steps to care for your memories will help you locate, reference, and re-use what you 
create. 

Legacy 
What you produce purposefully (like a home movie or photograph) and what you produce 
in daily life (like a calendar appointment or email) could be important for your loved ones 
and for the cultural record. 
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How to Reserve the Digital Memories Preservation Lab 

 
1. A customer must have a library card in good standing to book an appointment 
2. Navigate to https://thelibrarydistrict.org/  

a. Select: Using the Library from the menu bar 
b. Select: Digital Media Preservation Lab under the Services column 
c. Select: Book an appointment located under “How to Use the Digital 

Memories Preservation Lab” 
3. Navigate to https://lvccld.libnet.info/roomlist  

a. Select type: Digital Memories Preservation Lab from the menu on the left 
i. Take note of which location you are booking. 

4. Select Book Room (or Details then Book Room) for scheduling 
a. Green: Available  
b. Black: Unavailable  
c. Red: Clash/Time Conflict  
d. Yellow: Setup/Breakdown (Library Use) 

5. Select the requested reservation times (up to 4 hours), allowing a 30-minute buffer 
between appointments 

a. Note: You will receive an email when you reservation request is approved 
6. Sign the Participant Release Form at the beginning of your first session 

a. If you are younger than 18, parental/legal guardian consent is required 
7. Arrive for your first session 15-minutes early to check-in with staff 

https://thelibrarydistrict.org/
https://lvccld.libnet.info/roomlist
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a. Note: Staff may inspect the condition of your media to ensure it does not
harm the equipment

Identify Formats 

This guide is designed to help you identify the format(s) of your items and contains 
formats that the Memory Lab is able to digitize at this time.  

Audio 

Compact Cassette/Standard Audio Cassette 

• Compact Cassette logo on cassette
• Introduced in 1962
• Used for professionals and amateur recordings
• Likely polyester or acetate substrate
• Dimensions: 4’’ x 2.5’’ x ½’’
• Typically made of plastic
• Tape width is 1/8’’
• Each tape holds 30- to 120-minutes of content
• Most have 4 track stereo configuration with Tracks 1 & 2 on “Side A” and Tracks

3 & 4 on “Side B”
• Common Brands: TDK, Maxell, & Dolby
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CD  

 
• Introduced in 1989  
• Variations of CDs: R/RW/ROM  
• Typical capacity 700MB / 80min of audio  

DVD  

 
• Introduced in 1995  
• Variations of DVD: R/RW/ROM, etc. 
• DVDs produce high quality video discs with full menu navigation and Dolby Digital 

sound. 
• Standard DVD-Video can hold approximately 2.5 hours of video or slideshows 
• Dual-layer DVD-Video discs can hold approximately 5 hours at an average quality 

level 
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8mm  

 
• Introduced in 1932  
• Used primarily by amateurs, but some were made available for home use 
• Acetate and Polyester substrates 
• 8mm wide, perforations on 1 edge  
• Color or black & white.  
• Usually silent, but magnetic sound available  
• Negative, positive, composite  
• Image will likely be blurry- this was a form of film for amateurs 
• If the film is Kodak it will have edge code symbols that represent the year the film 

was made.  
• DO NOT TOUCH: Handle only the sides or use gloves 

Super 8mm  

• Introduced in 1965 
• Used primarily by amateurs, but some were made available for home use 
• Acetate and Polyester substrates  
• 8mm wide, perforations on 1 edge (smaller than regular 8mm) 
• Color or black & white 
• Silent or sound 
• Negative, positive, composite perforation of Super 8 is smaller 
• DO NOT TOUCH: Handle only the sides or use gloves  
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VHS  

 
• Introduced in 1976  
• Variation: S-VHS  
• Used for professional and consumer recordings 
• VHS logo on upper right hand corner  
• Dimensions 7.375’’ x 4.0625’’ x 1’’ 
• Typically, black plastic with white hubs and clear windows to show tape 
• Tape width is ½” 
• Sometimes in a plastic container, or paper sleeves 
• Common Brands: Sony, JVC, Panasonic, Fuji, Maxwell, & Q 

VHS-C  

 
• There will be a VHS-C logo somewhere on the middle of the tape  
• Tape width is ½” 
• Dimensions: 3.625’’ x 2.25’’ x 0.8’’  
• Typically, black plastic with a white hub and clear window 
• Common Brands: Sony, JVC, Fuji, TDKI, Panasonic  
• Can be played/digitized in a VHS player ONLY with an adapter (Adapter shown in 

example)  
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MiniDV  

 
• Introduced in 1995  
• Also Known As: DV or DVC  
• Used for professional recordings and amateurs 
• Cassette, 1/4” tape width  
• Logo on the left-hand side 
• Dimensions: 2.56’’ x 1.88’’ x 7/16’’ 
• Tape width is 5/16” (8mm)  
• Typically, dark gray tape with a light blue antistatic cover and 1 clear window  
• Often stored in clear, hinged plastic box 

Video8  

• Introduced in 1986  
• Variation: Hi8, introduced in 1989  
• Used primarily for amateur recordings 
• Tape width is 0.3125’’ (8mm)  
• Dimensions: 3.69’’ x 2.38’’ x 0.56’’  
• There will be a Video8 logo somewhere on the front side of the near the clear 

window  
• Typically, black plastic with white hub and clear window  
• Common Brands: Sony, Fuji, Panasonic 
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Digital 8 Tape 

 
• There will be a Hi8 logo or Digital8 logo somewhere on the front side of the tape 

near the clear window  
• Digital8 is recorded on standard Hi8 tapes 

o There may not be any distinguishing marks to indicate the recording is 
Digital 8 

• Tape width is 0.3125’’ (8mm)  
• Dimensions: 3.69’’ x 2.38’’ x 0.56’’  
• Typically, black plastic with white hub and a clear window  
• Common Brands: Sony, Fuji, Panasonic  

Hi8 Tape 

 
• There will be a Hi8 logo somewhere on the front side near the clear window  
• Dimensions: 3.69’’ x 2.38’’ x 0.56’’  
• Tape width is 0.3125’’ (8mm)  
• Typically, black plastic with white hub and clear window  
• Common Brands: Sony, Fuji, Panasonic 18 
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Film 

35mm Slides  

 
• Are Positive 

o Meaning you can see the image clearly as it was taken  
• Most are mounted in cardboard or plastic  
• When unmounted, slides have exactly 8 perforations on both sides 
• Horizontal orientation (regardless of image orientation) 

Film Positive  

• Can be black & white or color  
• The image will look just as prints 
• The camera’s “reversals” are made from negatives  
• Can be scanned and digitized  
• Through a chemical process can be processed into print  
• Positive film can be individual, strips, or framed  

Film Negative  

 
• Can be Black & White or Color  
• The camera’s “originals”  
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• Negatives are inverted  
o The image on the film is the reverse colors and luminescence of an image 

• Typically comes in long strips  
• Must be developed and processed to get a printable image 

Mixed Media Storage (Audio & Video) 

Floppy Disk  

 
• Floppy disks look like the Save icon on a computer 
• Size of floppy disk is actual measurement  
• Floppy Disks are 3.5” 
• Common Brands: IBM & Memorex 
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What We Sell 

USB Flash Drive 

 
• Known as a USB stick, USB thumb drive or pen drive  
• A plug-and-play portable storage device that uses flash memory and is lightweight 
• When plugged into the USB port, the computer's operating system (OS) 

recognizes the device as a removable drive and assigns it a drive letter 
• The drives support Microsoft Windows, Linux, MacOS, Linux and many BIOS boot 

ROMs 
• Sold by the library for $5.00 

MicroSD Card 

 
• A Secure Digital (SD) card is a tiny flash memory card designed for high-capacity 

memory  
• Used by various portable devices, such as car navigation systems, cellular phones, 

e-books, PDAs, smartphones, digital cameras, music players, digital video 
camcorders and personal computers 

• Sold by the library for $6.00  
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Compression Software & DVD Playable Software 

Handbrake 

 Handbrake is used for compressing videos. It has the ability to convert and 
compress a video from 100GB to 4GB. The logo for Handbrake is a pineapple and a fruity 
beverage.  

 
1. Insert storage device 
2. Open HandBrake 
3. Open your video file using Open Source 
4. Select video resolution and file format 
5. Click Open 
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Adjust the Settings 

 
1. Choose video resolution by selecting from the Preset dropdown menu 
2. Select General 
3. Select Fast 720p 30, Fast 1080p 30 or a resolution you prefer 
4. Choose video file format by selecting from the Format dropdown menu 
5. Select MP4 or another file format you prefer 
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Select Where to Save File 

 
1. Near the bottom, you will find the Save As text box 
2. Under Save As, make sure the file extension is part of the file name 

a. If the file extension is not included in the file name, the video will not play 
on all platforms 

3. Click Browse (near bottom right) 
4. Select the storage device you brought with you and select Choose Other Side 
5. The file will save under the HandBrake folder 

Compressing Video File 

 
1. Press the green Start button to compress your file, making it a more reasonable 

size 
2. The compressed video file will automatically save to the storage device that you 

selected 
3. When the file is finished compressing, close HandBrake 
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Saving Video File 

 
• If you change the save location, the files will be on your device 
• If you did not change the save location, the files will be saved to the HandBrake 

Files folder 
• Check your storage device to make sure that your movie is saved to complete the 

process 
• Repeat as necessary 

Finishing Your Appointment 

1. Double check your file 
2. Don't forget your tape 
3. Eject external hard drives, memory cards, etc. by clicking on the Eject icon next to 

the name of the device in the Finder window 
4. Notify staff when finished  
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Toast DVD 

 Roxio’s Toast DVD is the easiest and fastest way to create DVDs on your Mac. 
Toast DVD is the perfect companion for iMovie, making it easy to share your movies with 
friends and family. The logo for Toast DVD is a teal toaster with a DVD and film strip 
coming out of the top. 

 

Making a DVD 

1. Open Toast DVD  
2. Choose DVD-Video from the format selection menu 
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3. Click the Options button, if necessary, to reveal these optional disc settings: 

 
a. Menu Style: Choose a style for the menu background image, text, and 

buttons 

 
b. Quality: Toast DVD must compress video to fit onto the disc 

i. Choose the appropriate quality for the compressed video: 
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1. Good: Suitable for simple video, such as people talking—
fastest processing time 

2. Better: Suitable for most video—average processing time 
3. Best: Suitable for complex video, such as fast motion—

slowest processing time 
4. Custom: To create a custom quality level, click Customize and 

choose the Custom option from the Encoding tab 
c. Auto-play disc on insert: Select this option to automatically play the first 

video, slideshow, or playlist when this disc is inserted into a player 
i. The main menu would not be displayed, but can be accessed by 

pressing the MENU button on the player’s remote control 
d. Play all items continuously: Select this option to automatically play each 

video or slideshow on the disc without first returning to the main menu 
e. Include DVD-ROM content: Select this option to include additional data in 

the ROM portion of the disc 
i. This data will be accessible when the disc is used on a Macintosh or 

Windows computer 
4. Click Customize for additional disc settings 
5. Add video files to the disc by dragging and dropping them into the Content area 

from your hard disk or the Media Browser 

 
6. Insert a blank, recordable DVD 

a. Optional: Change the destination recorder and number of copies at the 
bottom of the screen 

7. Click the red Burn button at the bottom right of the Toast DVD window 
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a. Toast DVD displays a progress bar and status information as it records your 
disc 

 
8. You can preview a DVD-Video disc prior to burning an actual disc by saving it as 

a disc image file 

To Preview the DVD 

1. Instead of recording, select File > Save as Disc Image 
2. Give the disc a name, if you are prompted to do so 
3. Select a name and destination for the disc image file 
4. Click Save 

a. The disc image file is created 
5. Select the file, control-click, and choose Services > Mount It 
6. Use the DVD Player software included with Mac OS X to preview the DVD 

Making a High-Definition DVD 

High-Definition DVD is a unique type of video disc which allows you to author HD video 
to DVD for playback in true high-definition. This gives you the ability to create HD video 
discs without owning a Blu-ray Disc recorder. Although you are recording to standard 
DVD discs with this project, you can only view the finished project on a Blu-ray Disc 
player. 

• A standard, single-layer DVD can hold approximately 30 minutes of HD video 
• A dual-layer DVD can hold approximately one hour of HD video 

o While Toast DVD will allow you to add more than these lengths of video, 
adding additional video requires the video be compressed further and 
results in a lower quality video 

1. Choose DVD-Video from the format selection menu 

 
2. Click the Options button, if necessary, and select High-Definition DVD as the 

format 
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a. The other disc settings and options available are identical to those available 
when creating a DVD (see above) 

3. Add your HD video files to the disc by dragging and dropping them into the Content 
area from your hard disk or the Media Browser 

 
4. On the disc gauge at the bottom of the window, select DVD or DVD DL as your 

target media type 
5. Insert a blank, recordable DVD 

a. Optional: Change the destination recorder and number of copies at the 
bottom of the screen 

6. Click the red Burn button at the bottom right of the Toast DVD window 
a. Toast displays a progress bar and status information as it records your disc 

 

Finishing Your Appointment 

1. Double check your file 
2. Don't forget your tape 
3. Eject external hard drives, memory cards, etc. by clicking on the Eject icon next to 

the name of the device in the Finder window 
4. Notify staff when finished 
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Using the Video Transfer Station 

Sony DSR-45 DVCAM / DV / MiniDV VTR Player/Recorder 

 

To Get Started 

• Make sure that the DVCAM is powered on 
• To monitor audio during the digitization process, make sure that the speaker is 

powered on by turning the knob clockwise (to the right) 

What You Will Be Using 

 The software you will be using is BlackMagic Media Express. The logo is a film 
reel inside a stopwatch housing.  

 Additionally, you can use the optional iMovie software. The logo is a purple 
star with a white camera in the middle. The hardware you will be using is the Sony DSR-
20 DVCAM / DV / MiniDV VTR Player/Recorder.  
 
The DSR-45 is a videocassette recorder with a compact chassis. Equipped with a built-in 
LCD screen, the DSR-45 displays information including: audio level, system status, and 
the working image as they are needed.  
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• The controls that you will use are Eject, Play, Stop, Rewind, and Fast Forward 
• Never press record on the device as this will record over the movie 
• Make sure the DV Cam deck is powered on by pressing the Power button on the 

upper left-hand side of the deck 

Connect to the DV Cam 

1. Make sure the Audio and Video source selector buttons are on 1 
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Loading the Tape 

• There are two types: Regular DV and Mini DV 
o When loading Mini DV place the tape directly in the middle and load until 

the deck adjusts the size 

Capturing Video File 

 
 

1. Open BlackMagic Media Express  
2. When BlackMagic opens make sure that the Log and Capture tab is selected 
3. The preview window will allow you to see what is being played on the DV Cam 
4. Make sure that the DV tape is at the start position of the video or rewind the tape 
5. Press Capture at the bottom of the application 
6. Then press Play on the Sony DSR-45 
7. The computer will start recording 
8. When the video has finished playing, click the Capture button again to stop the 

recording 
9. You should now have a complete .MOV file of the tape 
 
• Don’t forget to eject your tape and take it with you 
• You can stop your DV or MiniDV tape at any time if you only want to capture part 

of the tape 
• DV and MiniDV tapes can be anywhere from 5 minutes to 2 hours long 
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Saving Video File 

In BlackMagic Media Express, when you hit capture the second time to end the recording 
of the video, BlackMagic automatically saves a .MOV file to the desktop 

Compressing Video File 

1. Open iMovie and click Create New and select Movie 

 

 
2. Import your file from the saved location by clicking the Import Media button 
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3. Click File > Share > File 
4. Name and describe your title 
5. The settings should be: 

a. Format Video and Audio 
b. Resolution 540p 60s 
c. Quality High 

6. Click Next  
7. Make sure the Where is located on your device 
8. Click Save 
9. When your file is done, iMovie will let you know with Share Successful 

Finishing Your Appointment 

1. Double check your file 
2. Don't forget your DVCam tape 
3. Eject external hard drives, memory cards, etc. by clicking on the Eject icon next to 

the name of the device in the Finder window 
4. Notify staff when finished 
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Video8 / Hi8 / Digital8 

 

What You Will Be Using 

The software you will be using is BlackMagic Media Express. The logo is a film 
reel inside a stopwatch housing.  

 Additionally, you can use the optional iMovie software. The logo is a purple 
star with a white camera in the middle. The hardware you will be using is the Sony GV-
D800 Digital Walkman which is a compact and portable Walkman for playing, recording, 
and editing your footage that features a 4" LCD monitor. The GVD-800 is a backward 
compatible VCR allowing the Hi-8 and 8mm tape playback.  

• The controls that you will use are Power On/Off, Eject, Play, Stop, Rewind, and 
Fast Forward.  
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• To eject, press and slide the button in the lower right-hand corner 
• Do not press record on the device or it will record over the tape 

Load the Tape 

1. Make sure the tape deck is powered on 
2. Load the tape into the deck by pushing and sliding the Eject switch to the right, 

opening the tray automatically 
3. The tape should be loaded into the metal slot face-up with the top of the video 

cassette sliding in first 
4. Gently push the tape deck closed 

a. You will hear the deck making noise after it closes, which is normal 
b. The tape can be rewound by pressing the REW button on the tape deck 
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Connect to the Sony GV-D800 Digital Walkman 
Make sure the Audio and Video source selector buttons are on 2 

 

Capturing Video File 

1. Open BlackMagic Media Express 
2. When BlackMagic opens make sure the Log and Capture tab is selected 
3. The preview window will allow you to see what is being played on the Sony GV-

D800 Digital Walkman 
4. Make sure that the video cassette tape is at the start position of the video or rewind 

the tape 
5. Press Capture at the bottom of the application 
6. Then press play on the Sony GV-D800 Digital Walkman 
7. The computer will start recording 
8. When the video has finished playing, click the Capture button again to stop 

recording 
9. Then press the Stop button on the Sony GV-D800 Digital Walkman 
10. You should now have a complete .MOV file of the tape 
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• You can stop your video cassette tape at any time if you only want to capture part 

of the tape 
• Video8/Hi8/Digital8 tapes can be up to 2 hours long 

Saving Video File 

In BlackMagic Media Express, when you hit Capture the second time to end the recording 
of the video, BlackMagic automatically saves a .MOV file to the desktop 

Finishing your appointment 

1. Double check your file 
2. Eject your video cassette from the Sony GV-D800 Digital Walkman 
3. Eject external hard drives, memory cards, etc. by clicking on the Eject icon next to 

the name of the device in the Finder window 
4. Notify staff when finished 

Wolverine Movie Maker Pro 

 
You will be using the Wolverine Movie Maker Pro which is a standalone converter. The 
Wolverine creators HD .MP4 video at 20 frames per second. It takes approximately 10 
minutes to capture one minute of film. 

Setting up the Wolverine 

1. First, make sure you have head and tail leader on your film roll 
2. Insert the SD Card in the back of the Wolverine 
3. MovieMaker Pro can only take a SD/SDHC memory card up to 32 GB maximum 
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4. Using a Micro SD Card with adapter, SDXC Card, or memory card that is 64 GB 
or above capacity, which is not compatible with MovieMaker Pro, will lead to a Card 
Error message 

5. Make sure the SD/SDHC card is unlocked, with the white tab in forward position 
6. Insert and push the SD/SDHC card inward until it clicks 

a. Improper insertion may damage the card reader or the SD/SDHC card 
7. To dismount/eject the SD/SDHC card, first push the card in then release 

a. Do not pull on the card directly 
8. MovieMaker Pro will power off automatically if the SD/SDHC card is being 

mounted/dismounted 

 

8MM and Super 8MM Film 

• Will require an SD card 
• Approx. time based on film reel length: 

Reel Length Time Length 

3” reel (50 feet) 2-3 minutes 

4” reel (100 feet) 5-6 minutes 

5” reel (200 feet) 12-14 minutes 

6” reel (300 feet) 19-22 minutes 

7” reel (400 feet) 26-29 minutes 

8” reel (500 feet) 34-37 minutes 

9” reel (600 feet) 41-44 minutes 
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Mount the Reels and Film 

If your film reel has an 8 mm mounting hole, mount the reel directly to the left shaft, 
otherwise use the red color reel adapter. If adapters are needed, always place the RED 
color adapter on LEFT side and the GRAY adapter on the RIGHT side. 

 
1. Mount empty reel on the right shaft 
2. Follow the Film Routing Diagram printed on the face of MovieMaker Pro to route 

the film to generate better quality videos 
3. Slide open the flap door, position film sprocket holes at the top 
4. Place film underneath the 3 white tabs 

Steps to Place Film on Table 

1. Place and hold film underneath Tab #1 
2. Twist film slightly and clip film underneath Tab #2 
3. Twist film slightly and clip film underneath Tab #3 

 
4. Make sure the film is properly placed underneath all 3 white tabs, then close the 

flap door. 
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Menu Selections 

1. Press the Menu button 
2. Use the Up/Down arrow buttons to highlight the Menu selection and press Enter 
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Record 

1. Slide the Film Selection Lever left (8 mm) or right (Super 8) to select the proper 
film type 

2. Then press the Enter button 

 
3. Press Enter/Start/Stop button to start recording 

a. While recording is in process, a red dot at upper left corner blinks 
4. Press Enter/Start/Stop button to stop recording 

Playback 

1. Press the Menu button, highlight the playback selection, and then press Enter 
2. Press Up/Down arrow buttons to select the film file to be playback, then Enter/Start 
3. Press Enter/Stop to pause the playback 
4. Press the Menu button one time to enter Edit mode 
5. Highlight Return (go back to Playback) or Delete (delete the current file) 
6. Press the Menu button twice to go back to record mode or main/home menu 

Rewind 

1. Rewind film from Light Table and swap reels 
2. Place the empty take-up reel on the right-side shaft and place sprocket holes on 

the outside (as shown) 
a. If a reel adapter is needed, always place the gray adapter on the right 

side/take-up reel 
3. Follow the film rewind routing diagram (the dotted lines) printed on the Movie 

Maker Pro and follow the instructions on the screen 
4. Press Enter to start/stop the rewinding process 

Exposure 

Exposure Value/Brightness needs to be adjusted before recording if default setting (0.0) 
is off: 

1. Adjustable exposure range is from 2.0 to -2.0 
2. Press Up/Down buttons to change the value and then press Enter  
3. Negative values provide a darker effect and an exposure value of 2.0 shows the 

brightest result 
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Sharpness 

If Sharpness adjustment is needed, make a change before recording. 
1. Sharpness range is from Low to High, with a default setting of Medium 
2. Press Up/Down to change the value and then press Enter  

 

USB 

Plug in the included USB cable to upload recorded MPF files. The SD/SDHC memory 
card is read as an external drive, called No_Name drive (G:)*. The stored MP4 files are 
located under the directory of FilmScanner/MOVIE.  
 
*Note: (G:) May vary computer to computer 

Frame ADJ (Adjustment) 

You can make adjustments of movie registers (the film center, X and Y and zoom-in/out 
factor on screen). If frame adjustments are needed, make changes before recording. 

 

Finishing Your Appointment 

1. Double check your file 
2. Eject your SD/SDHC Card from the MovieMaker Pro 
3. Notify staff when finished 
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DVD-VHS Player 

 

What You Will Be Using 

The software you will be using is BlackMagic Media Express. The logo is a film 
reel inside a stopwatch housing.  

 Additionally, you can use the optional iMovie software. The logo is a purple 
star with a white camera in the middle. The software you will be using is Blackmagic 
Media Express. The logo is a film reel inside a stopwatch housing. The hardware you will 
be using is the Sony SLV-D380P. 

Using the VCR 
• Uses the Play, Stop, Rewind, Fast-Forward and Eject functions 
• Do not use the record function 
• Always insert the tape into the VCR with the flap side and the clear windows facing 

up 
o If the tape is a VHS-C you will need the appropriate adapter 

 

Prepare the VHS tape 

1. Make sure the SL-VD380P DVD/VCR Combo Player is powered on and the Video 
option is selected 
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2. Insert VHS tape 
3. Be sure to rewind the tape to the desired position 
4. When the tape is where you wish to capture, press Pause 

VHS-C 

• The equipment can digitize SVHS, VHS, VHS-C and SVHS-C tapes 
• All tapes use half-inch tape; however, VHS-C and SVHS-C are 3.8 inches smaller 

in length and 1.5 inches smaller in width than regular VHS 
• VHS-C and SVHS-C require an adapter to digitize 

Using the VHS-C Adapter 

1. Remove the adapter out of the insert and place the VHS-C inside 
2. Slide the arrow button slowly until it opens the case 
3. Press the tape gently into the adapter  
4. Slowly close the VHS-C adapter lid back into place 
5. You will hear a noise that means the adapter is loading the tape 
6. Check to make sure the tape threaded properly 
7. Digitize as you would a regular VHS 

Capturing Video File 

1. Open BlackMagic Media Express 
2. When BlackMagic opens make sure that the Log and Capture tab is selected 
3. The preview window will allow you to see what is being played on the Sony SL-

VD380P DVD/VCR Combo Player 
4. Make sure that the video cassette tape is at the start position of the video or rewind 

the tape 
5. Press Capture at the bottom of the application 
6. Then press Play on the Sony SL-VD380P DVD/VCR Combo Player 
7. The computer will start recording 
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8. When the video has finished playing*, click the Capture button again to stop the 

recording 
9. Then press the Stop button on the SL-VD380P DVD/VCR Combo Player 
10. You should now have a complete .MOV file of the tape 
11. Don’t forget to eject your tape and take it with you 

 
*Note: You can stop your video cassette tape at any time if you only want to capture part 
of the tape. 

Saving Video File 

In BlackMagic Media Express, when you hit Capture the second time to end the recording 
of the video, BlackMagic automatically saves a .MOV file to the desktop. 

Using the DVD Player 
• Uses the Play, Stop, Rewind, Fast-Forward and Eject functions 
• Do not use the record function 
• Use the Eject button to open the disc tray 
• Always insert the DVD into the player with the image side facing up 
• When the DVD is where you wish to capture, press Pause 
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Prepare the DVD 

1. Make sure the SL-VD380P DVD/VCR Combo Player is powered on and the Video 
option is selected 

2. Push the Eject button to open the disc tray 
3. Insert the DVD 
4. Push the Eject button once the disc is inside to close the player 

Capturing Video File 

1. Open BlackMagic Media Express 
2. When BlackMagic opens, make sure the Log and Capture tab is selected 
3. The preview window will allow you to see what is being played on the Sony SL-

VD380P DVD/VCR Combo Player 
4. Make sure that the DVD is at the start position of the video or at the point you wish 

to record 
5. Press Capture at the bottom of the application 
6. Then press Play on the Sony SL-VD380P DVD/VCR Combo Player 
7. The computer will start recording 
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8. When the video has finished playing*, click the Capture button again to stop the 
recording 

9. Then press the Stop button on the SL-VD380P DVD/VCR Combo Player 
10. You should now have a complete .MOV file of the DVD 
11. Don’t forget to eject your DVD and take it with you 

 
*Note: You can stop your DVD at any time if you only want to capture part of the tape 

Saving Video File 

In BlackMagic Media Express, when you hit Capture the second time to end the recording 
of the video, BlackMagic automatically saves a .MOV file to the desktop. 
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Using the Audio Transfer Station 

TEAC Double Cassette Deck W-1200 

 
The TEAC Double Cassette Deck W-1200 can deliver digital audio at CD-quality (up to 
48kHz/16-bit PCM) to the computer, allowing digital archiving of your cassette tape 
library. Once you have digitized them on a computer, you are able to enjoy your old tape-
based music library. 

To Get Started 

1. Make sure that the tape deck is powered on 
2. To monitor audio during the digitization process, make sure that the speaker is 

powered on by turning the knob clockwise (to the right) 
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What You Will Be Using 

The software you will be using is GarageBand. The logo is a black amp speaker 
with a yellow sunburst guitar in front. For hardware, you will be using the TEAC Double 
Cassette Deck W-1200.  

• The TEAC has two cassette deck ports to transfer audio from one cassette to 
another 

o For the process of digitizing, you will only use one of them 
• The controls that you will use are Eject, Play, Stop, Rewind, and Fast-Forward 
• Do not press the Record button or this will record over the current tape 
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Loading the Cassette 

1. Press the Eject button on the left side, which will automatically open the deck 
2. Insert the cassette tape with the magnetic tape side down 

a. Cassettes usually have two sides, often referred to as Side A and B or Side 
1 and 2 

b. Make sure the side that you want to record is facing you 
3. Gently push the tape deck closed 
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Capturing the Audio 

1. On the computer, click once on the GarageBand icon to open 
2. GarageBand will open up to a Cassette Template 

 
3. Make sure that the cassette tape is at the start position of your audio or rewind the 

tape 
4. Press Record at the top of the application 
5. Then press Play on the TEAC  
6. The cassette track will start recording 

a. In GarageBand you will see a red recording bar moving across the screen 

Saving the Audio File 

1. Make sure your storage device is connected to the computer 
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2. In GarageBand, choose Share > Export Song to Disk 
3. To rename the exported file, select the Name in the Save As field, then enter a 

new name 
4. Choose the location to save the exported file to your storage device from the 

Where pop-up menu 
5. Select the format for the exported file (AAC, MP3, AIFF, or WAVE) 

Finishing Your Appointment 

1. Double check your file 
2. Eject your audio tape 
3. Eject external hard drives, memory cards, etc. by clicking on the Eject icon next to 

the name of the device in the Finder window 
4. Notify staff when finished 
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Using the Image Scanning/Transfer Station 
There are two Epson Scanners available. The Epson V850 comes equipped with film 
guide trays for negative and medium format film (120mm) as well as 35mm film slides. 
This scanner is also capable of scanning developed images but does so at a slower rate 
than the Epson FastFoto.  
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The Epson FastFoto is capable of scanning developed photos and documents in a range 
of sizes including 4x6 and 5x7.  

 
Each scanner has its own software program used to scan, edit, and store images. 

Using the Epson V850 
The software used for the Epson V850 is called Epson Scan 2. You will find it on the right 
side of the Mac desktop.  

1. To begin scanning, open up Epson Scan 2 
a. The window that will appear will have a list of settings, with the “Preview” 

and “Scan” options at the bottom 
2. To scan a developed image, place one photo at a time onto the scanning glass 

with the image face down 
3. Close the lid of the scanner, select the appropriate settings: 
4. Scan Settings should be set to Default 
5. Mode should be set to Photo Mode 
6. Document Source should be set to Scanner Glass 
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7. Document Type should automatically be set to Reflective 
8. All other settings, including Image Format, should be set based on the users’ 

preference 
9. Click Scan in the Epson Scan 2 window 
 

We recommend considering the file size when selecting settings for Resolution and 
Scanning Quality. 

 
To scan single 35mm slides, grab the appropriate film guide tray and slide the 35mm 
slides into the slots. Align the triangles on the tray with the triangles on the scanner and 
position the tray so that the notches go into the holes on the scanner. Remove the scanner 
cover from its lid, close the lid and open up the Epson Scan 2 software that is on the right 
side of the Mac desktop. 
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Settings for Positive Slides Should Be Set as Follows 

• Scan Settings should be set to Default 
• Mode should be set to Photo Mode 
• Document Source should be set to Transparency Unit 
• Document Type should be set to Color Positive Fil  
• All other settings, including Image Format, should be set based on the users’ 

preference 
 

We recommend considering the file size when selecting settings for Resolution and 
Scanning Quality. 
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To Scan Positive or Negative Film  

1. Grab the appropriate film guide tray  
2. Open up the tray clamp, sliding the film into the slots and close the clamp 
3. Align the triangles on the tray with the triangles on the scanner and position the 

tray so that the notches go into the holes on the scanner 
4. Remove the scanner cover from its lid, close the lid and open up the Epson Scan 

2 software  
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Settings for Positive Film Should Be Set as Follows  

• Scan Settings should be set to Default 
• Mode should be set to Photo Mode 
• Document Source should be set to Transparency Unit 
• Document Type should be set to Color Positive Film 
• All other settings, including Image Format, should be set based on the users’ 

preference 
 
We recommend considering the file size when selecting settings for Resolution and 
Scanning Quality. 

Settings for Negative Film Should Be Set as Follows  

• Scan Settings should be set to Default 
• Mode should be set to Photo Mode 
• Document Source should be set to Transparency Unit 
• Document Type should be set to B&W Negative Film OR Color Negative Film 

depending on whether the photos were shot to be in black and white or in color 
• All other settings, including Image Format, should be set based on the users’ 

preference 
 

We recommend considering the file size when selecting settings for Resolution and 
Scanning Quality. 
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Images scanned will be saved in a folder in Documents called: FastFoto 
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Using the Epson FastFoto 

The software used for the Epson FastFoto is also called Epson FastFoto.  

 
1. To begin scanning, open up the Epson FastFoto software 

a. The window that appears will have various options at the top; including Start 
Scanning, Share, Upload and Edit 

 

 
 

2. Load the photos onto the scanner’s feeder with the image facing you* 
a. Note that photos are scanned from the back to front; meaning that the photo 

at the back of the pile will appear first 
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*Please follow the loading capacity guide below to ensure the scanner is not overloaded. 

 
3. Next, click Start Scanning on the Epson FastFoto window 

a. A new window will pop up and require information about the photos to be 
filled out 

b. This information will be used so that the system can create organized file 
names, folders and tags 

4. Then click on the blue Start Scanning button at the bottom of the new window 
5. Photos will begin to populate the window 

a. Two versions of the photos will appear: One is unedited and the other is 
automatically edited by the system with improved photo quality 

 
Images scanned will be saved in a folder in Documents called: FastFoto. 
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Floppy Disks 

 
1. Insert the 3.5 inch Floppy Disk 
2. The drive will appear on the desktop 
3. Highlight all of the files you want to copy from the floppy disk 
4. Drag the highlighted files to your chosen storage destination 
5. Some older file formats may not be able to open with current operating systems 
6. It is still recommended that you move all the files off the Floppy Disk 
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Finishing Your Appointment 

1. Eject the Floppy Disk from the computer by dragging the drive on the desktop to 
the trash can, where it will turn into an eject symbol 

2. Eject the physical Floppy Disk from the drive by pressing the button in the upper 
right of the drive 

3. Notify staff when finished 

Origbelie DVD R/RW 

 
1. Insert the Disc DVD or CD 
2. The drive will appear on the desktop 
3. Highlight all of the files you want to copy from or to the disc 
4. Drag the highlighted files to your chosen storage destination 
5. Some older file formats may not be able to open with current operating systems 
6. It is still recommended that you move all the files off the disc 

What You Can Do with Digitized Files 
• Save them on your computer or external drive 
• Save them to the Cloud 
• Upload to Social Media Platforms 
• Share with friends and family 
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• Create Backups 
• Do not let your hard work go to waste – Protect your digital files and plan for their 

long-term preservation  
• Follow the 3-2-1 of digital preservation 

o Save 3 copies 
o Stored on 2 different media 
o 1 copy off-site 

What Software is available  

• Blackmagic Media Express 3.8.1: Software used for capturing video to the 
computer 

• Epson Scan: Scanner software with options for very high quality scans 
• Handbrake 1.5.1: An open source video compression and conversion tool 
• Gimp Image Editor 2.10: An open source image editor  
• GarageBand 10.4.7: An open source audio capture tool 
• QuickTime Player: Apple tool for video playback and simple editing 
• iMovie 10.3.5: Apples consumer video editing software 
• ToastDVD: DVD Burner for Mac 
• DaVinci Resolve 18.1.1.Build 7 

 
*Software is subject to change 

What Hardware is available 
• Mac Station 
• Input Devices 

o Epson Perfection V850 Pro Photo Scanner User Guide 
o Epson FastFoto Ff-680w Scanner User Guide 
o Sony DSR-20 DVCAM / DV / MiniDV VTR Player/Recorder User Guide 
o Sony Digital Video Walkman GV-D800 (Digital8) User Guide 
o Teac W-1200 Dual Cassette Deck with Recorder User Guide 
o Sony DVD Player/ Video Cassette Recorder SLV-D380P User Guide 

• Output Devices 
o Origbelie DVD R/RW User Guide 
o Chuanganzhuo floppy disk drive User Guide 
o Wolverine MovieMaker Pro 8mm/Super 8 (digital format .mp4) User 

Guide 
 

*Hardware is subject to change 

https://files.support.epson.com/docid/cpd4/cpd41530.pdf
https://files.support.epson.com/docid/cpd5/cpd55191.pdf
https://www.broadcaststore.com/pdf/model/17001/dsr20.pdf
https://www.sony.com/electronics/support/res/manuals/W000/W0004512M.pdf
https://assets.teac-usa.com/general/W-1200_OM_EFS_vC.pdf
https://www.manualslib.com/manual/160292/Sony-Slv-D380p.html?page=5#manual
https://m.media-amazon.com/images/I/A1tU5A8BxDL.pdf
https://d4804za1f1gw.cloudfront.net/wp-content/uploads/sites/56/2020/10/01110452/Chuanganzhuo-3.5_-USB-External-Floppy-Disk-Drive.pdf
https://www.wolverinedata.com/assets/downloads/MovieMaker_PRO_V_3.0_Manual_.pdf
https://www.wolverinedata.com/assets/downloads/MovieMaker_PRO_V_3.0_Manual_.pdf
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